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Getting Started 
 

To start up and open a dataset 

1. On the Start menu, select Programs, and then select Salient UXT, Salient Interactive Miner.  
 
The login screen should appear.  
 
If the server location(s) is not already configured, click on Edit to go to dataset server setup before 
proceeding. 

2. From the  menu, select a dataset.  
 
If you don't see the desired dataset, you might 
need to refresh  . 

3. For traditional login (i.e., user name and 
password entered directly into SIM), enter your 
user ID and password in the login screen. Then 
click Login. 

  

 
  

For external/SSO authentication, click the 
External Login button. If you are not already 
logged in, the next screen will allow you to enter 
your user name and password and Sign in. 

External/SSO authentication: 

 

For LDAP login (i.e., machine login used for 
authentication), the user name and password 
entries are not needed. Simply click Login. If 
you wish, you can log in as a different SIM user 
(e.g., on a shared computer). In this case, click 
Change User 

LDAP: 
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Tips 

For security reasons, we recommend exiting SIM (File, Exit) when you are finished. 

Contact your system administrator if you don’t know your user ID or password. Once you log in, you can change your 
password. 

Passwords are typically case-sensitive, depending on your organization's security settings. 

If you still do not see the dataset, it might not be running, or you may need to add it or select it in the list of dataset servers. 
Click Edit to manage the list of dataset servers. 

If two or more datasets have the same name, SIM lists the IP addresses of their servers next to the dataset names. 

When you exit, SIM saves user data and closes. This does not stop the UXT Server. 
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Overview of the screen 
After you start up and open a dataset (see page 5), you should see a screen similar to the following: 

 
• File menu – Select the file tab to open a menu with options to log into a dataset, export, change preferences, 

etc. 

• Quick-access toolbar – Lets you go to the home view, go back, and go forward. 

• Ribbon control – Includes tools to get to the desired information and customize the analysis window. The 
ribbon control can be minimized. 

• Context panel - Lets you select the data to show in the analysis window (e.g., change the dates, select the 
By, add data fields, etc.). 

• Analysis window – Shows a table or graph of the selected data. You can add multiple windows. 
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Select a starting point 
SIM offers several options for choosing a starting point that allows you to survey and drill deeper. 

Option Explanation 

Use the 
startup 
bookmark 

After logging in, the first screen you see may be the startup bookmark if one is configured in 
preferences, or a default layout of data. You can use this startup view if you wish, or choose 
a different view (see below). 

Open a 
bookmark 

In the Bookmarks panel, click the name of 
a bookmark to open it. 

Tips:  
If the bookmark panel is on autohide, place 
your cursor over its tab to open it. 

 
 
To search for a bookmark, click the folder 
icon  and then search in the dialog. 

 

  

 

Go to the 
home view 

Click   at the top of the SIM window to 
go to the home view. 

Tip: You can set the home view in 
preferences. 

 

Start with a 
Comparative 

The Comparative is a standard numbers 
table or graph that compares several 
groupings of data and may also compare 
two different date ranges. This may be a 
good starting point for investigation. 

To open a Comparative, click the 
Comparative button on the ribbon control. 
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Basic steps to find actionable information 
After selecting a starting point (see page 8), you can perform the following steps to dig deeper and find meaningful, 
actionable information. Refer to the appropriate sections in this document for more information. 
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Select the Dates 
You can change the dates or "timeframe" shown in any analysis. Many analyses (for example, Comparative 
Dimension Members) total data over the specified date range. Time-series analyses show data for each individual 
day, week, month or fiscal period in the date range. 

To select the date setup 

1. Click the   button in the analysis 
window toolbar, or click the Date 
Range area of the context panel. 

2. In the dialog, choose from the 
following date settings. 
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Option Explanation 

Resolution (i.e. days, 
weeks, months, or 
customized periods, 
etc.) 

In the Resolution box, click the radio button of the units you want to use. Time-
series analyses will show data for each unit of time separately. Other types of 
analyses widgets will total data for the units of time in the selected date range. 

If you choose Weeks, select a week-ending day from the Week Ending drop-
down menu. This option is not available if your administrator has set a global 
week-ending day. 

If you choose Months or periods and you are not setting a time-series date 
range, you can check YTD to see data for the first of the year to the selected 
month or period. 

Main date range (This) In the This Date box, select from the following to set the desired date range: 

• Enter the number of days, weeks, months, or periods in the date range. 

• Select the ending date of the date range by clicking and dragging the pointer, 
or click the drop-down arrow beside the end date shown to select the ending 
date from a calendar. 

• Optionally, you can set the starting date of the date range by clicking the 
drop-down arrow beside the start date shown. This automatically adjusts the 
number of dates in the range. 

Tip: If you are looking at the year-to-date (YTD), the beginning of the date range 
automatically adjusts to the first month or period of the year. 

Day filters (optional) You can choose specific days of the week or business days within the date range 
to analyze. Data for all other dates will be filtered out. 

Comparison date range 
(Last) 

The available time comparisons depend on the type of the selected analysis. 

In the Time Comparison box, choose one of the following: 

• Single shows data for This date range only. 

• vs. YAG compares data with the same time one year earlier based on a set 
of rules. 

• Advanced lets you select a different date range for comparison. After you 
click Advanced, set the Last date range using the options in the Last Date 
box. 

Comparison for 
incomplete timeframes 

  

If you are comparing months or periods that are incomplete (or may be 
incomplete when viewed) to a previous date range, then you should select a 
MTD/YTD Calculation Method under Modifiers to determine how to select the 
dates in Last date range.  
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Tips:   

If the dialog does not show the desired date range, you may need to change 
the data cube of the selected analysis window to one that includes those 
dates. 

 

An asterisk (*) appears before the names of incomplete period tables. If you choose an incomplete period table, This date 
range and Last date range must fall within the defined periods. 

Time-series date ranges require at least two units of time. 
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Group By and Focus 
Group By 
The Group By controls the following: 

• How data is grouped at the highest level (1st By). 

• How members can be expanded into additional levels of data (2nd By, 3rd By, etc.) in analyses that compare 
members.  
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To group By.. 

1. Click on the analysis 
window and then click 
under Group By in the 
context panel. Click on the 
level you want to change. 
By default, the context 
panel shows the 1st By and 
2nd By and may show 
additional levels if you have 
expanded members. If you 
prefer, you can use the 
Change By dialog (see 
below) to change multiple 
By levels at once. 

2. Select the key, and then 
select the new By.  

  

  

Tips:   

To change multiple By levels at 
once (i.e., the drill hierarchy), click 
Group By in the context panel. 
Then make the desired selections 
in the Change By dialog to set the 
1st By through the 5th By. This 
controls the downlevel order in the 
current window. The default 
downlevel order for new windows 
can be set in preferences. 

 

If the desired By is not listed, you 
may need to change the data cube 
using the drop-down menu in the 
context panel. 
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Tips:   

Users can click the breadcrumb 
path to change the 1st By.   
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Focus 
Focus in comparative analyses 
On an analysis comparing multiple dimension members at once (for example, Comparative Dimension Members), 
the row or column of the focus is outlined, and you can compare the focus to other dimension members. 

 

Focus in non-comparative analyses and key lists 
Other types of analyses, such as time-series, Scattergram, P&L Format, key lists, etc., only show data for the 
member in focus; therefore, you should know what the focus is and may want to change it. You can focus on all or 
the average of dimension members. 
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To change the focus 

1. Click the focus drop-down in the context 
panel. 

 

2. Select the new focus from the drop-
down menu or dialog. (A drop-down 
opens if the dimension has just a few 
members; a dialog opens if the 
dimension has many members.) 

 

  

Tips:   

If you select more than one member by checking boxes in the Change Focus dialog, SIM will filter out data for all other 
members. This is also referred to as "checkbox filtering." 

In non-comparative analyses (e.g., time-series), 
you can look at the total or average of all 
dimension members by selecting the All or Avg 
option at the top of the dialog. 

 

In comparative views, you can click on the row, 
column, or item in the analysis window to change 
the focus. 
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Insert Data Fields 
In key lists and most tables, you can insert data fields, which are sometimes referred to as "metrics" or "measures." 

To insert a data field 

1. Place your cursor over the 
column heading just before the 
place where you want to add the 
data field.  

2. Click the tools icon   to open 
the pop-up menu. 

3. On the pop-up menu, select 
Insert. 

4. Select the data field grouping 
(such as Sales) and then the 
data field if your organization 
has set up logical groupings. 
 
Or, select from a submenu of 
data categories, such as 
Volume, Costs, etc., and then 
the data field. 

 

 

  

Tips   

You may prefer to use the Insert Data Types dialog if 
you want to insert multiple data fields and/or mix, 
difference, percent change, etc. To access this dialog, 
select Setup on the Insert menu. 

 

To insert multiple data fields from the same category, 
select Insert some from the Insert menu. 

 

If you don't see the data field you want to insert, you 
may need to switch to another data cube. 
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Tips   

You can also insert data fields by clicking the  
button in the Data Fields section of the context panel. 

 

Pointer buttons (see page 20) are available to add 
Mix, Delta, and other computations. 

 

The Separator options on the Insert menu let you 
separate sets of data fields for easier viewing. The 
dash and equal signs are only available when viewed 
as rows. 

 

If you want to reuse a layout of data fields, you can 
save it as a setup. 

 

In key lists (see page 46), you can also insert properties (name, address, etc.), dimensions (channel, sales rep, etc.), and rank. 
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Show variance, mix, and other computations 
Some of the pointers, located in the Main tab, allow you to add variance, mix, and other computations to a table of 
numbers. 

 

Button Explanation 

 Delta For any data field, this button inserts the difference (Diff) and percent change (% Chg) 
between date ranges, or between actual values and budgeted goals. To add the 
difference/change percent between Last date range and This date range (This-Last), click 
the main data field heading, or to add the difference/percent change between any other 
values, click the appropriate subheadings in the order of the formula (e.g., This-Budget). 
You can also add the difference between average per period columns. 

Index This button lets you index members to a base or standard for one or more data fields. 
After activating the pointer, click the base member(s) and then the data field.  

Mix This button adds percent of the total (mix) contributed by each dimension member in a 
Comparative Dimension Members numbers view, each key member in a key list, or each 
unit of time in a Normal Trend or Comparative Time Series analysis. You cannot add mix 
for fields calculated with multiplication or division (such as per unit fields)SUM function. 

Average 
Per Period 

This button inserts the average per unit of time (per day, week, month, or period). For 
example, if you are looking at three months of data, this pointer will allow you to see 
monthly averages across the date range.  

  

To add variance (delta), mix, or average per period 

1. Click on the pointer button. 

2. Click on a column heading. 

3. When you are done using the 
pointer, click on the pointer 
button again or press Esc to 
turn it off. 
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Delete a data field 
If you have setup management rights, you can delete a data field. 

Option Explanation 

Delete Pointer Click the Delete Pointer   (located in the Pointers section of the main 
ribbon control). 

Click the headings of the data fields you want to delete. 

Press Esc or click the Delete Pointer again to turn it off. 

Data Fields area of context 
panel 

Click the data field name in the Data Fields area of the context panel. 

In the menu, select Delete. 

 

Double-right-click Double-right-click the heading of the data field. 
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Filter 
As you ask questions, you’ll likely want to narrow down or "filter" on subsets of the data. The Filtering area of the 
context panel shows the filters for the selected analysis window and lets you add or remove filters. Several 
methods are available for filtering. 

 

Tip: You can click on any filter in the context panel to change it, or double-click to remove it. 

Drill 
When you drill down, the selected member(s) becomes part of the path, all other data is filtered out, and the data is 
grouped by the next dimension in the drill order. 

 
You can use either of the following methods to drill down. 
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To drill on a single member 

1. Group the data (see page 13) by 
the dimension on which you want 
to drill. 

2. Double-click on the row, bar, pie 
slice, etc., representing that 
member. 

SIM adds the member to the path and 
filters out all other data. The data is then 
grouped by what was previously the 2nd 
By. 

Tip: If you want to select the next By 
(rather than using the 2nd By), you can 
click the drop-down arrow beside the 
Downlevel button: 

 

  

 

  

To drill on multiple members 

1. Group the data (see page 13) by the dimension 
on which you want to drill. 

2. Use the check pointer   to checkmark the 
members. 

 
  

3. Click the drop-down arrow beside the Downlevel 
button at the top of the analysis window: 

 
4. Select an option from the menu. 

SIM turns on a temporary collection as a filter. The 
data is then grouped by what was previously the 2nd 
By. 
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Add a filter 
You can add filters to view any subset of the data. Using this method, the selected member(s) do not become part 
of the drill path; they are simply turned on as a filter. In addition, the By dimension does not change. 

 

To add a filter 

1. Click the analysis window to select it. 

2. Under Filters in the context panel, click the 
 button. 

3. In the menu, select the key and then the 
dimension by which you want to filter the 
data. 

 

4. In the dialog, place a checkmark next to the 
member(s) you want view. 

5. Click OK. 
  

Tip: This method of filtering creates and turns on 
a temporary collection if you select multiple 
members. 
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Collections 
Collections are saved sets of members that you can use to filter the data. A collection can be created by selecting 
members or creating a test (Of These) to identify members based on criteria. Multiple options are available for 
turning on a collection.  

Filter data by a collection 
You can apply a collection to filter the data. If you wish, you can filter by multiple collections at a time. 

 

To filter by a collection 

1. In the Filtering area of the context 
panel, click the  button. 

2. In the Collections tree, expand the 
key or dimension and category 
(global, private, etc.) of the 
collection you want to turn on. 

3. Click the Filter radio button beside 
the collection. Dynamic collections 
(Of These) have the  symbol 
beside them. 

4. Click OK. 

Tip: Normally, turning on a collection 
shows data for only the members of the 
collection. If the Exclude selected 
members option is on for the collection, 
filtering by the collection shows data for 
all members except the members of the 
collection. 

 

 



Filter 

 SIM Training Guide — 26 

Show a collection by its title 
You can show a collection of dimension members by its title. This shows the collection as a whole so you can 
compare it with other collections and the total for the given context. 

 

To show a collection by its title 

1. If you haven't already, group By (see 
page 13) the dimension of the collection. 
This step is not required but is 
recommended in order to show the 
collection immediately after you turn it 
on. 

2. In the Filters section of the context 
panel, click the Collections  button. 

3. In the Collection dialog, check the 
Show By Title box in the row of the 
collection you want to display. This 
option is only available for dimension 
collections. 

4. Check additional Show By Title boxes if 
you want to compare multiple 
collections. 

5. Click OK. 

 

 
  

Tips:   

To show an entire folder of collections by title, right-click on the folder name and select Turn-On Show By Titles. 
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Tips:   

When Show By Title is on, the analysis shows 
the collection as a whole and treats it just like 
a dimension member, except that the focus 
window shows the characters "S-" (or "G_S-" 
if global). 

 

The "Totals" row only includes data for 
members of the selected collections. To add 
a row showing the total for all members in the 
context, you can turn on the Show Context 
Totals option. 

 
  

You can select how SIM behaves when you 
expand members using the plus button . By 
default, the collection expands into the 
members of the next By. You can select the 
Expand Collection Members option on the 
tools menu (under Design) to expand a 
collection into the members of the collection. 
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Create a collection 

Create a classic collection 
A classic collection contains a static list of key members or dimension members to allow you to filter out data for all 
other members. 

To create a classic collection 

1. In the Filtering section of 
the context panel, click the 
Collections  button. 

2. In the Collections dialog, 
locate the row of the 
collection's key or 
dimension. 

3. Underneath the key or 
dimension, select the 
category (global, private, 
etc.) and, optionally, 
subfolder where you want 
to save the collection. 

4. Click New. 

 

 

Tip: If you do not see the desired key, dimension, category, or folder, you may 
need to select options in the Show box in order to list more items in the 
collections tree. 
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To create a classic collection 

5. In the Edit Collection 
dialog, enter a collection 
Title. 

6. Under Available 
Members, highlight the 
members to add to the 
collection and click Add, 
or use other options in the 
Edit Collection dialog to 
add members. 

7. When you are done 
adding members, click 
OK. 

  

 

  

Tips: 

You can also save checked members as a collection or create a classic collection using an exception test (i.e. Of These). 

By default, collections filter out members that are not included in the collection. If you prefer, you can check the Exclude 
selected members box to filter out data for the collection members. This may help reduce the need to update collections in 
some situations. You cannot see the effect of this setting until you turn the collection on. 

For key members only, if you want to select from a list of all members of the key, check the Ignore Focus box; otherwise, the 
Available Members list contains only key members in the current context. 
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Create a dynamic collection (Of These) 
A dynamic collection is a filter that dynamically updates based on test criteria, such as revenue above a given 
value. Every time you turn a dynamic collection on, SIM reruns the test based on the selected settings and your 
current view. This is different than a classic collection, which saves a static list of members. This type of collection 
is only available for key members (e.g., customers). 

To create a dynamic collection (Of These) 

1. Before creating Of These: 

• We recommend removing all filters from the current analysis window unless the filter will be used for a specific 
purpose related to the dynamic collection.  

• Select the initial date settings (see page 10). Depending on the settings, this date range may dynamically 
update. 

• Turn on or off equivalents as desired. The Of These stores the equivalent settings used when it was created. 

2. In the Filters section of the context 
panel, click the Collections Plus 

  button. 

3. In the Of These dialog, enter a 
collection name. 

4. Click Create In to select a global 
or private folder. 

5. Set the Filter Level to the key you 
want to test (e.g., customer). 

6. In the Exception Test box, set 
the test criteria to determine which 
key members pass (e.g., 
customers that bought at least 
one unit). 

7. Under Passed In, select the part 
of the date range to consider for 
the test. Typically, All Periods (In 
Total) is recommended but 
additional options are available. 

8. To immediately filter by the 
collection, check the Display 
After Created box. 

9. If you wish, you can click the 
Options button to select from the 
following advanced options. 

10. When you are done defining the 
collection, click OK. 

Tip: Temporary collections are only 
stored for your current session. If you 
do not enter a name, the collection will 
be temporary. 
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Advanced options 

 

Option Explanation 

Context Shows your currently selected filters as well as the By. SIM will limit the collection to the key 
members that belong to or have data for the filters shown here (regardless of the context 
settings used when the collection is turned on). To change any of the filters, click the Change 
Context button. This button also allows you to change the date range, modifiers, and more. 

Limit To Allows you to use limit results based on the focus or currently checked members. 

Save As Leave Criteria selected in order to save the test settings as a dynamic collection so that it 
updates automatically. Otherwise, the collection will be a static list of key members (i.e. classic). 

Date 
Options 

Typically, you would leave Dynamic Date selected so that the date range updates 
automatically based on the date range of the currently-selected view. However, additional date 
options are available.  
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Customize 
Tools menu 
The tools menu includes various options to customize the analysis window. 

To open the tools menu 

In tables: 
Place your cursor over the upper-left box. 

Click the  icon that appears. 

 

In graphs: 
Place your cursor over the graph. 

Click the  button in the upper-left corner. 

 

The available options depend on the analysis mode and view type. The following list includes the more common 
options. 

Option Explanation 

Insert Insert a data field (see page 18). 

View Select a view type (table or graph). 

Design (tables only) 

- Borders Add and remove borders in tables. 

- Auto size columns Return columns to their default width. 
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Option Explanation 

- Highlight Settings Turn on/off and configure highlight settings. 

Options 

- Tree Options Expand or collapse dimension members. 

- Sort Select the primary or secondary sort (see page 35). 

- Pointer Tools Check or uncheck members; select the base for the Index pointer. 

- Display Settings In tables, you can Remove key and dim counts to prevent possible memory errors in 
large datasets. You can turn this option on in Comparative Dimension Members and 
other analyses, but counts will not be removed until you turn on a key list. 

In graphs, display settings may include 2-D/3-D, dynamic scaling, show or hide totals, 
and more. 

- Item Description 
Format 

Allows you to set options for displaying dimension member codes. 

Member Options 

- Export Export selected members to a text file. 

- Import Import a text file to create or append a collection. 

- Save as Collection Group selected members into a collection. 

Swap Swap columns and rows in a table or switch between vertical and horizontal bars in a 
graph. 
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Switch between view types 
Multiple types of views, including tables and graphs, are available to present the data in each analysis. 

To toggle between view types (e.g., table/graph) 
1. Select the analysis window you want to change by clicking on it. 

2. Click the button of the desired view type in the View section of the main tab, or click the numbers/graph drop-
down button at the top of the analysis window. 

 

Tip: If the currently-selected bookmark includes a custom report, it can be found in the view types area along with standard 
tables and graphs. Custom reports may have additional capabilities and limitations. See the custom report documentation for 
more information. 
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Sort 
To sort 

1. Click on the analysis window to select it. 

2. Under Other Settings in the context panel, click 
Primary Sort or Secondary Sort. 

3. Under Sort Selection, select whether you want 
to change the primary sort or secondary sort. 
The secondary sort is used to rank members that 
fall into the same place based on the primary 
sort.  

4. Under Sort Order, select from the following sort 
methods. 

5. Under Order, choose to sort in Ascending or 
Descending order (not used for "As Reordered"). 
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Option Explanation 

As Reordered You can put dimension members in a custom order. To use this option: 

1. In the Sort Order dialog, click the As Reordered radio button. 

2. From the drop-down menu by the Reorder button, leave 1st By selected to 
reorder the primary groupings, or select a different level of groupings to reorder. 

3. Click Reorder. 
4. In the Reorder dialog, do a combination of the following to place the dimension 

members in the desired order: 
 
- Choose from the drop-down menu to sort members alphabetically or as they are 
sorted in the current analysis. 
 
- Drag and drop members to the desired location in the window. 

 

Tip: You can search the list using the controls at the bottom of the dialog. 

Name Sort by names/descriptions. 

Number/Code Sort by codes. 

Data Sort by a data field. To use this option: 

1. Click the Data radio button. 

2. From the Data Type drop-down menu, select the data field. 

3. From the Time drop-down menu, select This, Last, or Budget if available. 

% Change Sort by percent change (not available in single time comparison). To use this option: 

1. Click the % Change radio button. 

2. From the Data Type drop-down menu, select the data field. 

Tip: By default, the analysis sorts by the percent change from Last date range to This date 
range (This-Last). You can change this calculation or sort by % difference versus budget (if 
available) using the Time and VS menus. 

Difference Sort by difference (not available in single time comparison). To use this option: 

1. Click the Difference radio button. 

2. From the Data Type drop-down menu, select the data field. 

Tip: By default, the analysis sorts by the difference from Last date range to This date range 
(This-Last). You can change this calculation or sort by difference versus budget (if available) 
using the Time and VS menus. 
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Option Explanation 

Invoice (Line Item 
only) 

Sort records by invoice number 

Date (Line Item or 
Time in Place only) 

Sort records by date. For non-transactional records, this option sorts by the starting 
date. 

Description (key lists 
only) 

Sort by other key member descriptions, such as address, phone number, etc. To use 
this option, click the radio button and then select a description from the menu. 

Dimension (key lists 
only) 

Sort by dimension member, such as region, state, zip code, etc. To use this option, 
click the radio button and then select a dimension from the menu. 

  

Tips:   

You can sort by a data field even if it isn't currently shown in the analysis window. 

You can also change the secondary sort, which controls the 
order of members that have the same value for the primary 
sort. To do so, click Secondary Sort in the context panel or 
choose the Secondary button in the dialog. 

This option is not available if you have reordered members. 
 

You can click a heading to sort; click again to reverse the 
sort order. 

 

The window uses the selected sort method until you perform a new sort or turn on a key list. Key lists retain their own sort 
order. 
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Highlighting 
You can turn highlighting on to spot areas of concern or importance. Highlight settings can be customized and 
reused. 

 

To turn on highlighting 

1. Click the arrow under the highlight 
button. 

2. You can select from a limited 
number of recently-used highlight 
settings in the menu, or select 
Setup Highlighted Data to access 
the dialog where you can access all 
highlight settings.  

 

3. If you open the dialog, select the 
desired highlight settings and click 
OK, or click New to add highlight 
settings. 
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Tips:   

You can click the Highlight button in the setup section of the main tab to 
quickly turn on or off the most-recently-selected highlight settings. 

 

You can apply new highlight settings to an individual column or row.  

1. Place your cursor over the column or row and click the   icon that 
appears. 

2. In the menu, select Highlight Settings. 

3. In the Highlight Setting Info dialog, define the highlighting criteria for 
the column or row. 

SIM temporarily stores the new or updated highlight settings in an "Undefined" 
highlight setting. You can save these highlight settings to reuse them in future 
sessions by opening the tools menu and selecting Design, Highlight 
Settings, Save Highlights. 

 

Preference settings allows you to change the shade of highlighting and the number of highlight settings listed in the drop-down 
menu. 
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Save and Share 
Bookmarks 
You can create a bookmark to save and share a view of the data. 

To add a bookmark 

1. Set up one or more analysis windows to use the By, date 
range, data fields, filters, and any other parameters of the 
bookmark you want to create.  

2. On the main tab of the ribbon control, click Save Bookmark 
or click the bookmark drop-down button and select Add 
Bookmark.  

Tip: Both options open the same dialog when you create a new 
bookmark; if you are saving changes to an existing bookmark, the 
Save option loads the existing bookmark name and other options. 

3. In the dialog, type a bookmark name and select from the 
following bookmark options. 
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Option Explanation 

Ignore Focus This option resets the focus to the first available member when viewed. 

Tip: When comparing members for an automatically updated date range (i.e., most 
recent or most recent complete), we recommend leaving this option checked to 
automatically go to the beginning of the list. In time-series views or other views that filter 
out data based on the focus member, we recommend leaving this option off in order to 
retain the filter. 

Date Options Choose how to update the date range of the bookmark. 

- Most Recent Automatically updates the date range to go to the most recent day(s), month(s), or 
period(s) in the selected data cube. This option can show incomplete months and 
periods. This option is not available for weeks (instead use Most Recent 
Complete). 

- Most Recent Complete Automatically updates the date range to go to the most recent complete week(s), 
month(s), or period(s) in the selected data cube. SIM uses a set of rules to 
determine what is considered to be complete. Most Recent Complete is not 
available for daily time resolution (instead use Most Recent). 

- Fixed Date Uses the date range selected during bookmark creation regardless of when the 
bookmark is opened. 

- Use current date This option is useful for budgets, non-transactional data, or other types of data 
cubes that may extend into the future. With this option on, SIM will use the current 
date of your system, rather than a future date in the data cube, to determine the 
date range when viewing the data.  

- Start Date For use with the Most Recent and Most Recent Complete options, this setting lets 
you control whether SIM will adjust the start date to use the same number of days, 
weeks, months, or periods as the original analysis, or adjust the number of dates 
to maintain a fixed start date. Select one of the following options from the Start 
Date drop-down menu: 

• Adjusted - will change the start date so that the results include the same 
number of days, weeks, months, or periods as the original analysis. The 
entire date range moves as time goes on.  

• YTD - Assigns the first day of the current year as the start date, regardless of 
the current date. With this option, the numbers of days, weeks, months, or 
periods change to include the first of the year through the most recent (or 
most recent complete) date. The date range grows as time goes on. 

• Fixed - Sets the start date of the original analysis as a fixed start date, 
regardless of the current date. With this option, the numbers of days, weeks, 
months, or periods change depending on when users view the data. The date 
range grows as time goes on. 

- Save as preferred 
options 

Save the currently selected Date Options as the default. 

Use as startup 
Bookmark/Supermark 

Use the bookmark as the initial view when you first start up or reset windows. 
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Option Explanation 

Use as default window 
Bookmark 

Save as home view (new windows or when you click the Home button ). 

Store multiple views as a 
Supermark 

Save all currently-open analysis windows, including the relative window sizes and 
whether or not their context bars are hidden, as a supermark. 

  

To add a bookmark (continued)   

4. Click Create in; then select the folder where you want to 
save the bookmark. If you have rights to create global user 
data, you can make a bookmark available to other users by 
saving it in a global category or one of its subfolders. 

5. Click OK.  

  

Tips:   

All components (setups, collections, etc.) of global bookmarks must be global. If you are saving a global bookmark that includes 
private components (setups, collections, etc.), then you are prompted to make the private components global. In this case, SIM 
retains a private copy of the bookmark component(s), but uses the global component(s) in the bookmark. 

If Knowledge Manager is configured, you can 
save a description and additional resources 
for the bookmark. 

 

You can change the date options for a 
bookmark at any time, by selecting it in the 
bookmark management dialog and clicking 

the  button. 
 

To edit any other aspect of a bookmark (By, data fields, etc.), open the bookmark, make the desired changes and then save the 
bookmark. 
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Export data 
You may be able to export analysis data to a file that can be used in another application, such as Excel. If you want 
to export this information on a regular basis, you might want to create a macro (see page 52).  

To export data 

1. Click on the analysis you want to export in order to make it 
active. 

2. On the File menu, select Save As. 

3. In the Save As dialog, from the Save as type drop-down 
menu, select a file type.  

4. Select a location and name for the file you want to export. 

5. Click Save. 

  

 

If you are exporting an encrypted Excel file, the Enter Password dialog will appear. Type and re-type the password 
required to open the file. This password must meet security requirements. 

Output preference settings control aspects of the file, such as what is included in the header and various 
Excel/CSV options. 
  

Email data 
You can email data from an analysis in order to share it with others. This function only works with MAPI-capable 
email software that is properly configured prior to use. If you want to email this information on a regular basis, you 
might want to create a macro (see page 52). When you email from within SIM, the analysis or list becomes an 
email attachment in the selected format.  

To email data 

1. Click on the analysis you want to send in order 
to make it active. 

2. On the File menu, select Send Mail. 
3. On the submenu, select one a format. 
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Advanced Topics 
Select the data in graphs 
In general, you can select the data fields in graphs using the following methods 

Graph type General instructions for selecting data fields 

Unlimited data fields: 

Comparative percent change, 
Comparative Time Series 
percent change, Mix 

Insert data fields or select a setup with the desired data fields in the 
Data Fields area of the context panel. 

 
These graphs are limited to the data fields that have been marked for 
graphs in the current setup. This setting is on for each data field by 
default; however, if you do not see a data field, you may need to mark it 
for graphs using the graph pointer in a tablet. 

 
Depending on your preferences, the data fields shown in percent 
change graphs may also be limited by presence or absence of percent 
change or difference columns.  
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Graph type General instructions for selecting data fields 

Limited to four or fewer axes 
(i.e., data families): 

Comparative actual value, 
Comparative Time Series actual 
value & ladder, Normal Trend 

These graphs show up to four data families (volume, unit currency, total 
currency, percent, etc.) and/or individual data fields—two along the left 
axis and two along the right axis. The graph will automatically include 
data fields within the first four families of data in the setup; however, you 
can configure each axis by clicking the axis label and selecting a data 
family or opening the dialog. 

 

Limited to one or two data fields 
at a time:  

Crosstab, Share Trend, 
Scattergram, Geo, Range, 
Exception, APM, Multi 
Comparative-2 and -4, Bubble 

Select the data field(s) or test under Data Fields/Setup in the context 
panel. 

.  

For a Crosstab graph, you can choose the first or second data field by 
toggling the Graph Second Data type option. 

 

Multiple data fields in tables, but 
limited to one or two data fields 
in graphs:  

P&L, Line Item 

Add the data fields to the analysis. Click the axis label to change the 
data field in the graph. 
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Key lists 
A key list is a table showing individual members of a key (e.g., customers). A key list is created when you "Group 
By" the key.  

 

 

To list key members 

1. Click on the analysis window and then 
click the top level under Group By in the 
context panel.  

2. Select the key, and then select a List 
option. 

The first list option filters the data based on 
the selected focus. (e.g., only customers in 
the regional chains channel).  

The second option (List all or List for all) 
turns off the focus and lists all members. 

 

  

Tips: 

If you don't see the key listed in the Group By menu or dialog, you may need to change the data cube. 

You can insert data (see page 18), change the setup, and more to change the columns included in the key list. 

To close the key list, click the  Turn-Off icon at the top of the key list or under Group By in the context panel. 
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MultiView 
MultiView lets you control multiple analyses within one window with a single set of context settings. When you 
change the context (By, focus, filters, etc.), SIM updates all the panes in the window accordingly.  

 

To turn on MultiView 

1. In the Main tab of the ribbon, 
expand the Analysis area and 
click the MultiView on option at 
the bottom. 
 
If the window is not already split, 
turning on MultiView splits the 
window into four panes using the 
default settings. You can also use 
the window options (located 
under Window on the main tab of 
the ribbon control) to split the 
window into your preferred 
configuration, such as four-pane, 
two-pane-horizontal, or two-pane 
vertical. 
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2. Customize the analysis type and view type of any individual pane using either of the following methods: 
 
Option 1: Click on a pane and then make the desired changes using the ribbon control, analysis toolbar, and 
other controls (see below). 
 
Option 2: Set up MultiView panes from a dialog (click the Multi-view button on the Analyses tab to access). 
This method also allows you to customize the time comparison and setup for each pane. 

 

MultiView date ranges 
MultiView allows you to define two date ranges—one set (This/Last) for comparative panes and another range for 
time-series panes. When you change the comparative date range, SIM updates all comparative panes; when you 
change the time-series date range, SIM updates all time-series panes.  

  

Tips: 

You can split a window without turning on MultiView; however, the panes will be limited to a single analysis type. 

Multi Comparative-2, Multi Comparative-4, and Multi Comparative analyses are not allowed as part of a MultiView window. 

To turn MultiView off, in the Main tab of the ribbon, expand the Analysis area and click the MultiView off option at the bottom 
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Advanced options for saving and sharing 

Storyboards 

View a storyboard 
Storyboards allow you to follow a path of investigation through pre-configured views or "steps" that can each have 
their own analysis type, view type, and other settings. When you view a storyboard, you can drill on whatever 
item(s) interest you to go to the next step, which filters out all other data. 

To view a storyboard 

1. In the storyboards section of the bookmarks 
and storyboards panel, click on the name of a 
storyboard to open it. The selected window 
then shows the starting point or "initial step" of 
the storyboard in storyboard viewer mode. 

In storyboard viewer mode, the storyboard viewer 
toolbar appears on the screen. 

 
In this mode, analysis types and some other 
controls are disabled because the storyboard 
controls the analysis type and other settings.  

 

2. Move through the steps in the storyboard. In 
general, you can double-click on an item or 
date to drill down. Continue to move through 
the storyboard until SIM notifies you that you 
have reached its end.  

Tip: At any time, you can duplicate the current 
window by clicking on the storyboard toolbar, 
and then follow your own path of investigation in the 
new window. 
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Create a storyboard 
The first task in creating a storyboard is to set up its starting point or "initial step." You can then create the next 
steps in the storyboard by drilling, customizing, and saving each step.  

To create a storyboard 

1. Set up the analysis window to show the starting 
view of the storyboard by selecting the Group By, 
date range, analysis type, and any other 
parameters as necessary. 

2. On the main tab of the ribbon control, click the 
storyboard drop-down button and select Build 
Storyboard. 

3. In the Create Storyboard dialog, type a 
storyboard name and select from the following 
options, which are the same as options available 
for bookmarks (see page 40). 

 
  

 
4. In the Initial Step Name box, type a name for the starting point of the storyboard. 

5. Click Create in; then select the folder where you want to save the storyboard. If you have rights to create 
global user data, you can make a storyboard available to other users by saving it in a global category or one of 
its subfolders. 

6. Click OK. 

SIM saves the initial step and goes into storyboard builder mode so that you can create the next steps of the 
storyboard. 

In storyboard builder mode: 

• The storyboard builder toolbar appears on the screen. 

 
• Toolbar buttons and other controls are enabled or disabled based on what you are currently allowed to do. 



Advanced Topics 

 SIM Training Guide — 51 

  

7. Drill down - If the next step should drill down, 
you can double-click on the member or date. 
Note that storyboard builder does not store 
the specific item(s) on which you have drilled 
down; instead, SIM will allow the user to 
select the item(s) when viewing the 
storyboard. If the next step does not drill-
down, proceed to Step 8.  

 
  

  

8. Configure - Customize the storyboard 
step by making the desired changes. 
For example, you might change the 
analysis type, view type, By, data 
fields, sort, etc.  

9. Add step - On the storyboard builder 
toolbar, click Add Step. In the Add 
Storyboard step dialog, enter the 
name of the step and click OK. You are 
now ready to create another step in the 
storyboard if you wish. 

 

10. For each step in the storyboard, repeat 
Steps 7 through 9... drilling down, 
making changes, and then adding the 
step each time. 

  

 

11. When you are finished creating steps, click  on the storyboard builder toolbar. 

After creating a storyboard, you should view it (see page 49) in order to test its settings. 

Tip: All components (setups, collections, etc.) of global storyboards must be global. If you are saving a global storyboard 
that includes private components (setups, collections, etc.), then you are prompted to make the private components global. 
In this case, SIM retains a private copy of the component(s), but uses the global component(s) in the storyboard. 
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Macros 
Macros allow you to quickly print, export, or email commonly-used views of the data. You can run macros within 
SIM whenever you wish and/or automate reports by scheduling macros (see page 55). Possible output formats 
include Excel, TXT, HTM, etc. 

 

To create a macro 

1. Set up an analysis to use the By, date, focus, sort, 
modifiers, collections and any other parameters of the 
view you want to export or print. 

2. On the main tab of the ribbon control, click the macro 
drop-down button and select Manage Macros. 

 
  

3. In the Manage Macros dialog, click New. 

4. In Analysis tab of the Macro dialog, type a macro name.  

5. Select from the following date options, which are the 
same as the bookmark date options (see page 40). 
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To create a macro (continued) 

6. By default, the macro uses the same settings as the analysis configured in Step 1. If you want to change any 
of these settings, click the appropriate tab and do so. 

 
• Analysis - analysis type and data field setup. 

• Path - Group By, focus, drill path, and output FOR EACH dimension member. 

• Filters - collections, single member filters, and output FOR EACH key member. 

• Modifiers - math options, calendar days, etc. 

• Sort 

• Output - table/graph, key list settings, and output options (e.g., print or save file) 

• Options - additional options related to expanding members , highlight settings, hidden fields, and 
more. 

• Email (if configured) - settings for emailing macros results (see Step 8). 

7. To select the output type, click the Output 
tab.  
 
Under Output Options, click Save As if you 
want the macro to export the results to a 
file(s). Choose from file options to control 
names, columns, and display settings for the 
output file. Then, click the File button to 
specify the file type, name, and location. 
 
Or, choose Printer if you want the macro to 
print to your default printer. With this option 
selected, you cannot email macro results. 

 
  

  

 

8. If you want the macro to email results, click the Email tab and select settings for emailing the results. Your 
administrator must enable this option in order to access this tab. 

9. Click OK. 
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Scheduled macros 

Enable scheduled macros and enter status email settings 
You can schedule a macro to run automatically using a task scheduling program and the parameters provided by 
SIM. A scheduled macro outputs the results to a file or email based on the specifications in the macro output (see 
page 52) and email settings. The following setup is required before you can schedule a macro (see page 55). 

To enable macros and enter status email settings 

1. On the main tab of the ribbon control, 
click the macro drop-down button and 
select Manage Macros. 

  

 

2. In the Manage Macros dialog, click the 
Schedule button. 

3. In the Scheduled Macro Settings 
dialog, check the Enable Scheduled 
Macros box. 

4. Enter the following information to set up 
the status emails for all scheduled 
macros. These are not the same as the 
email settings for the results emails 
sent by macros.  

• Outgoing Mail Server (SMTP) - 
Select a server that has been 
entered by your administrator or 
enter a server. 

• From Address 

• To Address(es) - When entering 
multiple addresses, separate them 
with a semicolon (;). 

• Subject 
5. Click OK. 
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Schedule a macro 
If you have enabled macros (see page 54) in SIM, you can schedule the macro in your preferred task scheduling 
program. 

To schedule a macro 

Follow instructions in the task scheduling program to 
create a scheduled task. 

To access the necessary information to set up the task, 
including program path and scheduled task argument: 

• Right-click on the macro or folder of macros in the 
Manage Macros dialog and select Show 
Scheduled Task Settings. 

  

 

• In the Scheduled Task Arguments dialog, in the 
Optional Parameters section, choose an option 
for sending status emails. The selected option will 
populate the arguments shown in the dialog.  

• Copy and paste the program path and arguments 
from the Scheduled Task Arguments dialog into 
the task scheduling program. To copy, select the 
text in the dialog, right-click, and choose Copy. 

  

 

  

Tips: 

Before you can run a scheduled macro that is stored in local user data, you must force a macro save, either by clicking the 
Save button in the Manage Macros dialog or by exiting SIM. 

Scheduled macros cannot print. Any macros set up to print will be skipped if run via a scheduled task.  

You can schedule multiple macros to run at once if they are in the same folder. Right-click on the folder name to see its 
arguments. 
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Knowledge Manager 
Knowledge Manager enables users to organize thoughts or “soft knowledge” for collaboration. You can add text 
descriptions, upload images or other resources, and add comments. In addition, this information can be shared 
between all users across multiple devices in SIM, Salient Dashboards, and the Salient Mobile app (additional setup 
required).  

To show the Knowledge Manager panels 

In the View tab of the ribbon control, click the 
Knowledge Manager button and then the name of the 
panel. 

Knowledge Manager includes the following panels. 

 

  
  

Bookmark Info   

Allows users who create bookmarks and 
storyboards to write a descriptions and purposes 
for them. 

Resources (links to web pages, pictures or 
documents) or comments can be included as 
future reference materials become available. 
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Member Info  
  

Allows you to connect media or non-media 
information to specific customers, sales reps, 
products, dates, etc. 

Entries can be filtered and sorted to keep the 
most current information on top.  

Media examples include news stories, events or 
related websites. 

Non-media can be details on location, entry, 
specific contact info, or security issues. 

 

General Info    

General: Add global information such as 
manuals, training material, or information about 
the dataset. 

Index/Search: Search, view, or add information 
about the schema (keys, dimensions, data fields, 
etc.). 
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Salient Management Company offers business 
and government a new solution for efficient 
management. Drawing on diverse data from 
multiple sources, Salient technology measures 
how business activity creates value, quality, 
financial efficiency, and productivity, while the 
user interface eliminates barriers to using this 
knowledge for continuous process 
improvement.  
 
Salient is a worldwide provider of advanced 
performance management and decision 
support systems for a wide range of industries 
and the public sector. Founded in 1986, Salient 
today serves more than 115,000 users in 61 
countries.  
 
For more information, visit www.salient.com. 
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